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INSIDE: NOSTALGIC ART

NOSTALGIC ART Many of us have an interest in saving railroad stations from the wrecking ball across
the country. These stations represent a bygone era of architecture, history, adventure,
SIMPLY SIGNS and memories. A few years ago, | met a couple who inspired towns to restore many of
the stations in our region through their artwork. Maywood, Oradell, and Demarest are
GSD WINTER MEETING a few of the stations that have been, or are in the process of, being restored.
MEETING MINUTES | met Mary and Barry
Shiff at a craft show
Go FOR THE GOLDEN SPIKE! . . in Montclair, NJ. This
was the last place |
SHow AND TELL expected to find any-
thing train related. |
PoINT/COUNTERPOINT: was expecting to

(o)M=l =D RIS ANS SO enjoy the beautiful
day with my wife,
strolling from one
craft booth to the
other. Jewelry, pho-
tos, and paintings are
what attract our inter- |
ests at these shows. &
But on this day, my
stroll came to a halt
when | walked into
the Shiff’s booth. On the wall and in bins were many prints of New Jersey railroad sta-

THE GARDEN STATE DivISION tion paintings that Mary and Barry have made over the years. Literally, there were
prints from A to Z, actually W. Beginning with Allendale and ending with Wyckoff, near-

E-MaiL ly 50 in all. And on this day, | bought a print of the railroad station in Wayne, NJ, my

GSDTRAINS @YAHOO.COM hometown.

WEBSITE: The Shiff’'s didn’t begin using railroad stations as subjects, right away. At first, they

WWW. TRAINWEB .ORG/NERGSD/ focused on trains and ships. But, they didn't sell well. They started to find success

when they started painting city scenes of Atlantic City, Hoboken, and Paterson NJ.
Then, after creating a painting of the Tenafly railroad station, they haven’t looked back.

While Mary passed away a couple years ago, Barry continues the work they started. It
typically takes months of research before work can begin on a painting. Barry will comb
the internet, old post cards, and old picture books, looking for information on a station.
The search is made difficult since many stations have been altered from their original
state. For example, the Wayne, NJ station no longer exists. And, in my research for
this article, | found three photos of the station. But, only one of the three shows the
“Nostalgic Art” continued on page 12
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Happy New Year! And for the Garden State Division, it is
looking very happy. For the first time, we have all of our
meets set for the entire year. We plan on getting the dates
out to the magazines and sites and they are all posted on
our website as well. Plus we already mailed out your annu-
al post card so you know all the dates too. Sadly we only
mail that card to GSD members but even if you are not and
wish to come, please do as all of our event dates are post-
ed in this issue of The Whistle Post. We also changed the
time of our fall meet to 10 AM. If this works we may change
others in 2009 as well. Anything we can do to draw more
members, we will.

Now all we need is you, yes you, to open your home to our
membership before or after the meet so our membership
can see your layout, your progress, your trains. You don't
have to be a great modeler, or even have a finished layout.
We want to see it. You set the time and the hours and what-
ever you set will be a great help to us and at the same time
you will be sharing your knowledge and your enjoyment of
the hobby with people just like yourself and if your not care-

by President T om Wortmann

ful, you might even make new friends.

You can see that our new editor is doing a fine job but don't
let that stop you from submitting an article or two as well.
He won't turn you down and you don't have to be a writer
either. He will even work with you to get your article looking
the best it can be.

Besides our meets, we also hold staff meeting 4 times a
year and they too are open to all members. Feel free to
attend those as well to voice your ideas and hear ours. No
charge and you will get to share a cup of coffee with your
officers. The staff of the GSD works for the entire division
and you are a part of that division. Email any staff officer for
dates and directions as staff meetings are held in the
homes of the staff and not in public areas - but you are still
very welcome to attend we just need to know who is com-

ing.

Remember it's your division, it's your hobby. Make it a great
one. ®

== THE CABOOSE

A Long W inter

You know it is a long Winter when you receive two winter
issues of The Whistle Post, back to back. It was suggested
that the issue of The Whistle Post coincide with the season
it is published in. So, here we are, experiencing a second
Winter. Keep the faith, though, Spring is just around the cor-
ner.

Since it is a long Winter, how about warming things up a lit-
tle beginning with this issue? I've started a new feature,
which | hope becomes a standard in these pages. The fea-
ture is called "Point/CounterPoint".

No, this isn't a Saturday Night Live parody of 60 Minutes.
Instead, this feature is intended to provide information from
both sides of a subject. The opposing viewpoints should be
presented in a fun, constructive, and informative way. If you
are expecting "flaming," you will be disappointed. | think the
internet provides more than enough opportunities for "flam-
ing" and | do not welcome it within these pages.

You will see that in this issue, Tom and | have started the
ball rolling with the first topic of computerized switch lists. It
is a topic that both of us have some experience with. | con-
tinue to use computerized switch lists and Tom does not.
Hopefully, the objective of this column is reached and you

by Editor Chuck Diljak

are a more informed reader if you are in the position of
deciding to use computerized switch lists or not.

For this column to be successful, | need readers to provide
subjects and their positions on these subjects. I'm sure
each of you has plenty of both and express them, everyday.
All it takes is for you to step on to the platform and write it
down.

Future issues will bring other new features, as well. | am
planning to dedicate one or two pages for photos from the
readers of The Whistle Post that focus on a theme in each
issue. The theme for the photo page in the Spring 2008
issue is “Bridges” and is identified in The Whistle Post col-
umn, as shown on page 11. Submit photos you have taken
of prototypes or models that fit this theme and submit them
to The Whistle Post. These ideas have the intention of
showcasing what our division members are doing in the
World’'s Greatest Hobby.

My mailbox has unlimited capacity, and right now the nee-
dle is pointing to empty. So, drop me a line, article, or photo
at gsdwhistlepost@yahoo.com.

Is it Spring, yet? @

@®The WHISTLE POST
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AT THE THROTTLE!:

Simply Signs

f you remember your first day of kinder-
Igarten, you probably remember being ter-
rorized by the thought of remembering all

those colors, letters, and shapes. Oh, the

by Chuck Diljak

my own.

Let's pick this sign apart into its components
before we build it. To start, there is a black dia-

stress of a five year
old.

WE SELL

mond, over a red
rectangle, over a

Fast forward to
today. You need a
special sign for
your model, but
none exist. So you
have to create it.
But, instead of
paper and crayons
of those kinder-
garten days, you
need to use a com-

LEHIGH VALLEY

ANTHRACITE

white square with
black text. There
are your colors and
shapes. Notice the
four different text

fonts: "We sell",
"Lehigh Valley
Anthracite”, "LV",

and "Coal that satis-
fies" are made from
different fonts.
There are your let-
ters. Now, let's start

puter.  Oh, the
stress of being an
adult.

The Coat thal Slisfics

building the sign
and put these indi-
vidual components

But, it really isn't
that hard! Stop using that expensive piece of
furniture for only sending and receiving e-
mails. Start exercising its electrical circuits to
their fullest potential by making a sign. | bet
when you look back at those kindergarten
days, you think learning shapes, letters, and
colors really weren't that difficult. Hopefully, by
the time you finish this article, you will feel the
same way about making a sign on your com-
puter.

A friend of mine posted a sign on one of the
many model railroad forums for Lehigh Valley
Anthracite (Figure 1). This sign is just what |
need for my layout due to my interests in the
Lehigh Valley and coal mining. But, | didn't
want to use it since there were glare spots on
it and it was skewed. So, | decided to create

Figure 1. Prototype Sign

together.

The first thing | do is determine the software to
use. My computer came with Picturelt. Itis a
photo editing software that has additional fea-
tures that can be utilized for sign making. | can
add shapes, letters, and colors, easily. And,
when | add these objects, they are added as
their own layer in the image. By stacking each
object, or layer, you can build your final image.
Objects can be brought forward or sent back-
ward so that they overlay other objects in the
proper order. Another advantage of each
object being in its own layer is that you may
need to resize it, change the color, or change
another property of the object. There are other
packages that have this ability as well. Check
out your computer to see what programs you
may already have for editing photographs.

Each software program works differently. You
may need to perform some reconnaissance
on your software program to find the functions
| will use with Picturelt. Look over each of the
menu options in your program to find these
functions.

To begin, | started with a white square with a
border around it (Figure 2). In Picturelt, | used
the menu at the top of the screen by selecting:
Insert » Shape

“Simply Signs” continued on Page 4




“Simply Signs” continued from page 3

Then, | selected the shape | wanted from
a visual menu. In this case, | selected a
squarefrectangle.

Picturelt placed the shape in the work
area. When you look at the shape, it has
four points in the corners and four points
at the midpoints on each side. Using
these points, you can shrink or expand the
shape of the item using your mouse and
dragging the point to where you want it.

After setting the size of the shape, | need-
ed to add a border. Using the mouse, |
right clicked on the shape. This brought
up a menu where | selected:

Change shape or line » Line thickness

For this sign, | changed the line thickness
to be “4 pt.”

The next step is to add a red rectangle to
the image. Just repeat the same steps as
before, only this time, you want the rec-
tangle to be exactly the same width as the
square you created before. And, the

Figure 2. White box
with black border

height should be less than the height of
the square.

Create a black border for the rectangle in
the same way the border was created
with the square.

The last step is to change the color of the
rectangle. | did this by selecting:
Change shape or line » Fill Color
A palette of colors will appear. And, |
selected the red color (figure 3).

The next step is to add a black diamond to
the center of the red rectangle. | followed
the same steps to add a shape, but

Figure 3. Red box
with black border

instead of a square/rectangle, | added a
diamond.

Note that when the diamond is creat-
ed, the points for expanding or shrink-
ing the shape are just like the locations
on a square/rectangle. However,
Picturelt creates the diamond by con-
necting the midpoints on each side of
the rectangle.

Once the diamond was created, | made
the rectangle the same size as the red
rectangle. This will center the diamond
perfectly within the red rectangle.

The next step is to modify the line thick-
ness, the line color, and the fill color of the
rectangle. Using the steps earlier, | made
the line thickness “2 pt” instead of “4 pt".
Using the steps outlined above, | changed
the fill color to black. To change the line
color, | selected from the menu:

Change shape or line » Line color

In this case, | changed the line color by
selecting white from the color palette.

At this point, all of the shapes and colors
have been added to the sign (figure 4).

The last step is to add text. Finding a font
that matches a prototype sign is tricky.
But, | usually find something close on two
websites | use for fonts:

www.1001fonts.com
www.fonts101.com

Figure 4. Black diamond
with white border

There are many fonts to choose from and
install on your PC. For this sign, | used
four fonts:

Arial; “LV”

Britannic Bold: “WE SELL”

Loki Cola: “The Coal that Satisfies”
Pop Warner: “LEHIGH VALLEY
ANTHRACITE”

Adding the text to the image is very sim-
ple. | selected from the menu:
Text » Insert Text

| created five separate text boxes, one for
each line of text. | inserted the appropri-
ate text in each box. To change the font
and the font size, | selected from the
menu:

Text » Font

There are a couple other features of these
software products that you may want to
take advantage of.

The first is called grouping. If you have
multiple objects in your sign and need to
move them in unison, you can group them
together so that their position, in relation to
each other, is frozen. In Picturelt, | do this
by holding the shift key down and select-
ing each object with the mouse. Then, to
group the objects, | select:

Edit » Group

The other feature you may need to take
advantage of is the layering of objects.

Frequently, you may add an object and
need to place it behind another object.

“Simply Signs” continued on Page 1 1
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THE CLuB CAR:

GARDEN STATE CENTRAL MODEL
RAILROAD CLuB

607 8TH AVENUE

AsBURY PaArk, NJ 07712
WWW.GARDENSTATECENTRAL .COM/
100% NMRA CLuB

GARDEN STATE MODEL RAILWAY
Cius

575 HiGH MOUNTAIN ROAD
NorTH HaLEDON, NJ 07508
WWW.GSMRRCLUB.ORG

MODEL ENGINEERS RAILROAD
CLuB OF NEwW JERSEY

569 HicH MouNTAIN RoOAD
NoRrTH HaLEDON, NJ 07508
WWW.ANGELFIRE .COM/NJ4/MERRC-
NJ/

THE MobDEL RAILROAD CLUB
295 JEFFERSON AVENUE
Union, NJ 07083
WWW.TMRCI.COM

NEw YORK SOCIETY OF MODEL
ENGINEERS

341 HoBokeEN RoAD CARLSTADT,
NJ 07072
WWW.MODELENGINEERS.ORG/

THE RAMAPO VALLEY RAILROAD
CLuB

620 CLIFF STREET

Ho-Ho-Kus, NJ 07423
WWW.MEMBERS.AOL .COM/RVRRCLUB

NEw JERSEY DIVISION OF THE
NMRA MiD-EASTERN REGION
WWW.NJDIVNMRA .ORG/

SEND CLUB INFORMATION TO

MEMBERSHIP AND CLuB CONTACT:

Tom CASEY
TCASEY @CO.BERGEN.NJ.US

Winter 2008

GSD Winter Meeting:

CALLING ALL
RoOUND ROBINS

Frequently, NMRA members or guests will ask if there

are any Model Railroad Round Robins in the Garden

State Division. We know of some Round Robins, but

not all. We would like to refer these inquiries to the

Round Robin groups. But, we need your help.
Please send the group name, general location, con-
tact phone number and e-mail address for the

Round Robin group to:

Tom Casey
TCASEY(@CO.BERGEN.NJ.US

“GSD Wi inter Meeting” continued on Page 9
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Purpose:
Garden State Division (GSD) Meeting

Date/Time:
November 11, 2007 at 9:30 AM

Place:
Home of Roger Oliver in Denville, NJ

Attendees:

Tom Casey, Ciro Compagno, Ed
Fraedrich, Norman Frowley, Roger Oliver,
Anthony Piccirillo, Bob Tumielewicz, and
Tom Wortmann

Convention Committee Report

The Fall Meet was debriefed, which was
held in conjunction with the All Scale
Swap Meet hosted by The New York
Society of Model Engineers in E.
Rutherford, NJ. Members reviewed the
successes and areas of needed improve-
ment. The single clinic, Computerized
Switch Lists by Chuck Diljak, was well
received. Two other planned clinics did
not take place.

Ed Fraedrich provided a nicely made
wooden caboose donation box for this
event. A few improvements were sug-
gested to better advertise the donation
box at future GSD events. No donations
were collected.

The next Greenberg show in Somerset,
NJ will take place at the Garden State
Exhibition Center on January 5-6, 2008.
Bob Tumielewicz will follow-up with
Greenberg Shows regarding the set up of
a GSD Table. It was agreed that, if allow-
able, a table located just outside the main
floor would be ideal to catch visitors enter-
ing and leaving the show.

Bob Tumielewicz was asked to solicit cli-
nicians for the upcoming Winter Meet.

Home Depot Committee

The committee was formed to have a
GSD event at the Riverdale, NJ store in
2008. The committee consists of Ed
Fraedrich, Roger Oliver, and Anthony
Piccirillo.

) MEETING MINUTES

Whistle Post Report

The need for a standardized Whistle Post
format and its mission statement were
reviewed. Roger Oliver volunteered to
prepare a draft. Once completed, the
GSD Board and Directors will review and
implement going forward.

Roger Oliver requested that a reminder
be put on the front and back of The
Whistle Post indicating that all subscrip-
tions renew in January 2008.

A draft copy of the new Whistle Post,
emailed to the President was briefly
reviewed. All were extremely pleased and
the staff requested some changes and
additions.

Treasurer's Report
Roger Oliver indicated there was minimal
activity.

Education Committee and AP Reports

BY SECRETARY CIRO COMPAGNO

takes place followed by an operating ses-
sion hosted by the club. Tom Casey
needs an approximate headcount partici-
pating in the operating session before the
event.

Spring Meet

In April or May 2008, at The Model
Railroad Club in Union, NJ. Roger Oliver
will approach club.

Summer Meet
Sunday, August 24, 2008, 12:00PM at
The Garden State Model Railway Club in
North Haledon, NJ. Ed Fraedrich will con-
firm with club.

Fall Meet

Saturday, Oct 25, 2008, at the New York
Society of Model Engineers in Carlstadt,
NJ. It was suggested that this meet start
earlier as not to run out of time.

GSD Nominating Committee

Norman Frowley proposed a scoring sys-
tem to determine winning of the annual
The Paul Mallery Award. Suggested
improvements were made. Ideally, the
award is presented during each Winter
Meeting. Roger Oliver accepted the offer
to provide sample wording for the wooden
plaque.

Secretary's Report

It was suggested that the Secretary e-mail
a meeting reminder to all Officers and
Directors and attach the last meeting min-
utes. It was also suggested that Anthony
Piccirillo send the reminder to all GSD
members to boost awareness and partici-
pation.

It was suggested to review and update the
Officers and Director's  Contact
Information.

Calendar for 2008
GSD events were reviewed and updated:

Winter Meet

Sunday, January 20, 2008, 12:00 pm at
The Ramapo Valley Model Railroad Club
in Ho-Ho-Kus, NJ. The snow date is Feb
17, 2008. The annual business meeting

The committee reviewed the slate of qual-
ified candidates for election of Officers
and Directors in 2008:

President

Tom Wortmann 2008-2009
Vice-President

Norman Frowley 2008-2009
Secretary

Ciro Compagno 2008-2009
Treasurer

Anthony Piccirillo 2008-2009
Directors

Andrew Brusgard 2008-2010
Tom Casey 2008-2010
Ed Fraedrich 2007-2009
Roger Oliver* 2007-2009
Bob Tumielewicz 2007-2009

* Completing Anthony Piccirillo's term

All officers and two directors are up for
election.

The next meeting, the winter meet, is
scheduled as noted above.
Meeting adjourned around 12:30PM. ®

@®The WHISTLE POST



MODELING TiIP: 2 Go FOR THE GOLDEN SPIKE!

BACKGROUND:
Using alcohol washes with ARSI sleRR (=IETIVE]
B [[elt=Neli= NI R [EER Ml Scale Rails know, 2008
has been designated
PROBLEM: ‘The Year of the MMR",
Tl ST o= RISl [[WeiicRis] and the magazine will

seal the decals or weathering JEEIGICEE: o [SRNCETo

powders they just applied to their jelgiigRigtz1R{eldVENe]gNoll

model. Then, in order to weath- FURUEEEEVEIRETlEIEN

er the model some more, they JUEiReUR\ZE e[RRIl

T VAR I o] ViilosWistld MMR program.  The |

is alcohol based, such as alcohol [BIEle=lgglel= gy
and ink or Rust-All. This results [ugS{e=lRRETEXeelpleT gl
(- R ICH S T WIS o LT Tolelg] & "History of the NMRA
the model. Achievement Program
(1961-2007) by C. J.
SOLUTION: Riley. In that article, |
Apply a second dose of Dullcote JleElfglleRigtinigl=Nelello [Ty
to the model. This will eliminate BSULCRAVEI(¢RYEEMIISE
the white residue. (oLe]lY tuted by the NMRA in
enough, you can also use this[RLYMESIONINe=lEldelile]y

deposits left by water, which is

CONGRATULATIONS:

GOLDEN SPIKE
BRuUce DE YOUNG
WEST MILFORD, NJ

ASSOCIATION OFFICIAL
RoGER OLIVER * NER 444
DENVILLE, NJ

MASTER BUILDER-SCENERY

BRrRuce DE YounG * NER 447
WEST MILFORD, NJ

an MDC frame

MODELING TIPS CAN BE SENT TO

by Bruce De Young

Figure 1: An Athearn Gondola

O ENRTR IR == IR Of its 20th Anniversary, let's take a closer that the Master Modeler Awards require, but
IR ES VR SR CHUlEE [0ok at the Golden Spike Award. it does require the modeler to demonstrate

basic modeling skills in several areas:

ORIl The Golden Spike Award, although not one  Rolling Stock (Motive Power & Cars); Model
tive tenders. of the eleven awards that can be applied to Railroad Setting (Structures & Scenery); and

Engineering (Civil & Electrical).
Since | just went through the process
of getting ready for the Golden Spike,
| thought | would show you quickly
how straightforward it is. Let's look at
each of the three areas in sequence.

-

Rolling S tock:

The requirement here is to display six
(6) units of rolling stock. (You can dis-
play these units at a Division meeting
or just on your layout/module when
the team comes to see your work.
They do not have to be judged in a
.y contest!) To qualify, the rolling stock
'_° can be scratchbuilt, built from crafts-
man kits, or be detailed commercial
kits. (A 'shake the box' kit by itself, will
not qualify.) To give you some ideas,

the MMR, is often mentioned as a great way here are some things | did.

to enter the program. That is exactly the way

| viewed it as | decided to put my toe in the An Athearn gondola received wire grabs, a
waters of the Achievement Program. scratchbuilt load, and some weathering (fig-

ure 1); another Athearn kit (a flat car) got a

JaXeia (|2 = V1SNl el TGN NIl The Golden Spike does not require the level  weathered deck and a scratchbuilt lumber
NorRmMAN FROwLEY, MMR of expertise in the various areas of the hobby load; | built a boxcar from a wood craftsman

NORMANFROW @AOL .COM

“Golden Spike” continued on page 12
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STEAM LOCOMOTIVE PARTS

FLUESU
LEPZAF
SLDTNC
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RJCESS
BWGAOT
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WORDFIND CLUES:

BOILER
COMPRESSOR
CROSSHEAD
CYLINDERS
DRIVERS
FIREBOX
FLUES

FRAME
GENERATOR

OmMmM—~—u0WOAIN-HO>» D CO
XZ0ZmMA>»mMQO>»>mMT o
rgmrzao-drroT

<MAUIUVZICTOTMOKT I
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>WWO0O“C0IZ2Z0nD0Z2WW>X> 2T
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INJECTORS
JOHNSONBAR
PILOT
PISTONS
PUMP
SANDDOME
SIDERODS
SMOKEBOX
STEAMDOME
TENDER
VALVEGEAR
WHISTLE

%> The Empire Junction ‘O8R

The Northeast
Region Model
Railroad
Convention

Presented by The Central New York
Division
September 11-14, 2008
Liverpool, NY

For more information, visit our website at
www.empirejunction.ay

Introducing the best deal

in model railroading.
Join the NMRA for 6 months for just $9.95°!

+ Easy access to one of the world’s largest railroad libraries

+ Experience fellowship and fun with other members in your area
+ Get low rates on special insurance for your layout or collection
+ Receive 6 monthly issues of Scale Rails magazine

+ Be a part of programs like *Modeling With The
Masters,” Estate Counseling, contests and more!

Visit www.nmra.org to see what you’re missing!
Fill out this form, include your payment of $9.95 (US. |
funds only) and mail it to: NMRA - Rail Pass
Membership, 4121 Cromwell Road, Chattanooga, TN

|

1

1 I =Rail Pass offer is good in the US. only and
1 37421-2119. Or sign up online at www.nmra.org.

1

I

1

1 is for new members and those who have

not been NMRA members for two years

I or more. Individuals can only join at Rail

35 rates one tme; membership renewal

I il be 2t the regular membership rate.

1 Rail Pass members can vote, attend con-

wenthons and participate in contests, but

I cannoc hold office and will not receive &
Mew Member Pak,

Name

: Address

: City/StZip

I Phone ( )

1
| Email

1
lD Check [] Credit card

: Credit Card #

: Credit Card Exp.

"~ 5o much bang.
1 So few bucks.

1 Signature

@®The WHISTLE POST



NEXT DIVISION

May 4, 2008

LOCATION:

THE MobDEL RAILROAD CLUB
295 JEFFERSON AVENUE
Union, NJ 07083
WWW.TMRCI.COM

DIRECTIONS:

RoOUTE 22, BEHIND THE HOME
DEPOT. FOR DRIVING DIRECTIONS,
VISIT:

WWW.TMRCI.COM

AGENDA:

MODEL JUDGING

CLiNnIcs

SHow AND TELL

WHITE ELEPHANT TABLE
LIGHT LUNCH

MassIVE OPERATING SESSION

CosT:
$5 ApMmISSION FEE

CLiNic CONTACT:

IF INTERESTED IN PRESENTING A
CLINIC AT A DIVISION MEETING,
PLEASE CONTACT EVENT CHAIR:

ROBERT TUMIELEWICZ
RTUMIELEW @AOL .COM

WELCOME TO NEW
GSD MEMBERS:

BERT EDWARDS
HILLSBOROUGH, NJ

MICHAEL MAZzEO
RAHwWAY, NJ

PERRY SQUIER
NEWTON, NJ

ROGER SuHR
EbisoN, NJ

Winter 2008

“GSD Winter Meeting” continued from page 5

...Clinics make it to

the Winter
Meeting at the Ramapo Valley Railroad
Club in Ho-Ho-Kus, NJ, in January, you
really missed something!

Yes, we had reports from the various
departments. And, yes we had elections
of officers. But, after that things got much
more interesting.

Norman Frowley presented Achievement
Program awards to Roger Oliver and
Bruce De Young.

Meredith Taylor, from the Friends of the High
Line, presented a clinic on the preservation
and reuse of the High Line, a 1.5 mile elevat-

If you didn’t [

Norman Frowley (1) prenting an
cate to Roger Oliver

AP certifi -

ed railway that runs along the west side of
Manhattan.

Kevin Olsen presented a clinic that covered
the beginning of steam locomotives.

The clinics were followed by an operating
session on the Ramapo Valley Railroad.
The dispatchers, Chris Freeman and 13
year old Jimmy Brennan, successfully
routed trains operated by GSD members
over the club layout. Thatis no easy task.

Now, a normal railroad would not send all
of their trains out over their lines with
rookie engineers. But, that is what the
Ramapo Valley Club did. We may not
have made money for the railroad, but
we sure had fun. A big thank you to the
club for hosting the GSD!

Come to the Spring Meeting in Union, NJ
on May 4 to continue the fun. Details are
to the left of this article. ®

Show and Tell

Beginning with the Spring Meeting at The
Model Railroad Club, in Union, NJ, there
will be a new segment to the program
called “Show and Tell.”

The objective of “Show and Tell” is to share
with other members of the GSD a project
you completed or are currently working on.
No paperwork, PowerPoint presentation,
hand outs, or judging. Just bring in a
model and tell us about it. How did you
build it? Is there a prototype for the
model? What interested you about this

model? What did you learn from building
the model? What details did you add to the
model? How did you paint and decal the
model?

The idea is to share with everyone what
you have done and not be overwhelmed by
giving a clinic or having the model judged.

So bring some of those prized model to the
May 4th meeting and tell us all about them.
Details about the meeting are to the left of this
article. See you there....with your models! ®
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CounterPoint

“L ovE ‘EM”
By Chuck Diljak

om is probably going to write about how laborious it is to

I work with a computer program that generates switch lists
for your operating sessions. And, while creating car cards

and wayhills only needs to occur once, so does setting up your
railroad in a computer program. However, developing the switch
lists for each operating session in a car cards/waybills environ-
ment could also be perceived as laborious. So, maybe both
systems are a "push” when it comes to laborious.

"But what about all the setup time for the program
when you start?" may be Tom's quick rebuttal.
While it is true that the setup of your railroad in
the program at startup is time consuming,
just remember that you only need to per-
form this task once. Then, when you

generate each operating session, it is
just a matter of clicking a button and print-
ing the switch list. With car cards and way-
bills, you don't invest nearly the amount of time
in the beginning to get this system going. However,
in between each session, you need to flip the waybills
and create the switch lists for the next operating session.

"Yes, but car cards and waybills are self correcting!" could be
Tom's next argument. What is "self correcting?" In car cards
and wayhills, the card stays with the car. So, if an operator
misses picking up a car, it is no big deal. Another train in the
current session or a future session can pick the car up then.
With computerized switch lists, it is generally believed that
the computer pre-determines where cars need to be ahead
of time in order for trains to pick them up. As a result, trains
cannot deviate from their schedules. That was probably true
in the days Tom played with his old DOS program. But,
today, many of the leading programs offer real-time opera-
tion. So, if a train misses a car or is behind schedule, it is no
problem. Even if you miss the car, you can always update
the car’s location in the program for the next session.

"But what about the poor guy who isn't computer-savvy?
Some of these programs have a learning curve!" may be
Tom's strongest argument. However, many of the software
companies provide support. And, there are even user
forums where you can get help from other users. Just
remember, every user started at the same point.

So, don't dismiss computer switch lists without trying them.
Many of the programs can be downloaded and tried on a
trial basis before you purchase. See which ones work for
you and which ones don't. In the end, either way you
decide, you are operating your railroad. And that is a card
Tom and | both like to play. ®

COMPUTERIZED
SWITCH LISTS

“HATE ‘EM”
By Tom Wortmann

ell Chuck got the page heading correct if nothing
Welse. I'm a diesel fan and a diesel over my head

looks fine to me. | would have used an Alco, but
what the heck.

Computers are great. For people like me who have no clue
how to spell they are wonderful, once | figured out what the
wiggly red lines meant. Of course now I'm dealing with
green wiggly lines, | work on those at another time.

Anyway, People do seem to forget that comput-
ers are stupid, they don’t create data they sim-
ply work with data, YOUR data. The data
you inputted. The computer is not smart,

it's really stupid. Now if you’re not good
with a keyboard or just not crazy about
sitting in front of a computer, for hours,
well, then you could have real problems. Or
maybe you're the guy who works on computers
all day. Now isn't that what you want to do? Come
and sit in front of it again? Oh the joy.

Also understand that unless you are a computer whiz, you
will need to buy a program in which you input all your data
in (for hours). They run from expensive to very expensive
and then there are the updates, will it work 5 years down the
roads with 98, XP or VISTA's replacement? Will the com-
pany go put of business next year or so? Well, don’t worry
about that. Just buy more computers like Chuck. Now you
have work to do and don’t make a mistake or you may have
to re-input all that data again or spend more time wondering
why ladies underwear keeps getting delivered to the meat
packing plant in covered hoppers. Hmm maybe you did
make a mistake. Chuck will tell you that you only have to
input the data once, yea right, just don’'t buy any new cars
or locos, don't add or change industries, add track or heav-
en forbid — remove something from the railroad.

Ok, now lets assume that you spent all that time, you don’t
make any mistakes, everything is perfect. So now you are off
and running. Congratulations. I'm impressed. Personally |
would have rather spent that time working on the layout but
that's just me, not Chuck. Also since Chuck does not know
what self correcting is, let me try to explain; you toss the old
card or waybill and fill out another one, whenever you
please.

Hey, things are rolling, cars are being picked and delivered
and goods are being shipped. Wow, it works. Then it hap-
pens, that 50 box car with computer parts derails. It's a bro-

“CounterPoint” continued on page 12
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Photo Theme for the Next Issue:

Bridges
ach issue of
EThe Whistle
Post will feature
a page or two cen-
tered on a theme.

THE SUBMISSION DEADLINES FOR
THE WHISTLE POST:

: p = iy For the Spring 2008
OCTOBER 10 : ' 4 S issue, the theme will

be “Bridges.”
CONTRIBUTORS TO THIS ISSUE: ' ! At o Please submit model
CirRo COMPAGNO ; | N E g or prototype photo-
BrRuce DE YounG ; o a . graphs you have

Tom WORTMANN . : - _ - taken, along with a

o : s description, to gsd-
whistlepost@yahoo.co
m that fit this theme! ®

THANK YOU! Stone arched bridge on the Ramapo V  alley Railroad
Club’ s layout in Ho-Ho-Kus, NJ

NEXT ISSUE’'S PHOTO THEME: . . .
e, “Simply Signs” continued from page 4

For example, what if | created the diamond And, now you have a completed sign. Now it
after creating the “LV” text object? Without is a matter of saving the sign, just as you
doing anything, the diamond will overlay the would do with any other document. However,
“LV”, making the “LV” invisible. To bring the | saved my original image as a “.png” image.
“LV” to the top, | select: This will allow me to change any of the objects
Format » Move Forward or Backward » Bring in the image that | want. However, to use the
to Front image for decals and signs, save a second
version of the image as a “.jpg” or other stan-
Besides “Bring to Front”, there are also options  dard photo format.
to “Send to Back,” “Bring Forward,” and “Send
Backward.” Give it a try with your software! ®

Subscribe to The
HISTLE POST

The Official Publication of the Garden S  tate Division of the NMRA Northeast Region

Name

:
:
:
:
:
:
:
:
1
CONTRIBUTIONS CAN BE SENT TO: E
CHuck DiLiak Address :
31 KulkeN CouRrT H
WAavNE, NJ 07470 City State Zip i
1
:
.
:
.
:
.
:
.
i
1
1

GSDWHISTLEPOST @YAHOO.COM
NMRA#

. A subscription to the Whistle Post is $7.00/Year
SEND ADDRESS CORRECTIONS TO:

ANTHONY PICCIRILLO Please send a completed copy of this form and a check made payable to the Garden State Division to:
748 WEST SHORE TRAIL Anthony Piccirillo, T reasurer, 748 West Shore T rail, Sparta, NJ 07871

SPARTA, NJ 07871

ANTHONY 13TRAINS @EMBARQ- The date in the corner of the mailing label shows when your subscription ends = 1/09
MAIL .COM All subscriptions run from January to January
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“Nostalgic Art”
continued from page 1

awning over the end window depicted
in the Shiff's painting. It is this atten-
tion to detail that | admire in their work.

Today, many towns are beginning to
notice the beauty in these old sta-
tions. Chances are the station is cur-
rently in sad shape. But, when local
citizens and officials see the paintings
the Shiff’s created of their railroad sta-
tion in its prime, many towns are will-
ing to restore them. Some towns
have converted restored stations into
museums, quant little shops, or use
them for civic events.

If you are interested in displaying a
print of your local station or stations
from your favorite railroad in your
home, you do not need to wait for a
local craft show. You also don't need to
wait for the next Greenburg Train and
Toy Show in Somerset or Edison,
where Barry often has a booth.
Instead, call Barry at (201) 944-1813 or
e-mail him at BarryShiff@gmail.com.
Barry will be happy to tell you what sta-
tions he has in his catalog.

If you are wondering about pricing,
the smaller 6x9 prints sell for $40.

Even though | bought my painting
after the station met its demise, many
visitors to my layout comment on the
print. Maybe I'll buy a print of a sta-
tion that still exists, next time. Who
knows, maybe it will get restored. @

“Golden Spike” continued from page 7

kit (Main Line Models) and added some
brake rigging; | stripped the lettering
from an Athearn work caboose, re-paint-
ed and decaled it for the Susquehanna,
added a wood deck and wood sides,
and details like wire grabs and non-
working marker lights; | scratchbuilt a
wood-sided gondola on an MDC frame
(Figure 2); and | added homemade
decals to an undecorated refrigerator
car.

You get the idea. All you need to do is
add some weathering, details, decals, or
loads t0 A Eoms ;

'shake the box' -' \
kit, and it will
qualify. It is !
also a great :
way to get start-
ed in this
aspect of the |
hobby!

Model
Railroad
Setting:
The  Golden
Spike requires
you to build
eight (8) square

feet of layout
(or an 8 square
foot module) and construct five (5) struc-
tures. Here you want to display some
basic skills in building structures and

Figure 3: Roundhouse scene in rail yd

adding scenery. As with the rolling
stock, the structures have to be a bit
more than a styrene kit built straight from
the box. Once again, they can be
scratchbuilt, built from craftsman kits, or
simply be commercial kits to which you
have added weathering and details.
However, scratchbuilding is not required
and neither is building a huge craftsman
kit. You can meet this aspect of the
Golden Spike by painting, weathering,
and adding details, just as you did with
the rolling stock. Remember, bridges
are considered structures, too. Now

building structures is probably my
favorite aspect of the hobby, so | had a
lot to choose from. By the way, the yard

“Golden Spike” continued on page 13

“CounterPoint” continued from page 10

ken coupler, looks like the box let go.
Hmmm, you can't finish the job with a
car like that. Me? I'd take it off the road
and replace it with another. Car card and
all, oh wait, you can't do that can you?
So you stop the session, run upstairs,
turn on the computer and tell it that the
car is bad ordered and you replaced it
with what? You can't just take a car out
of the drawer, you have to assign it? Oh
wait, how did it get there? | guess you
can fudge that right? Just hope it does-
n’t mess up the next session. Ok, update

the records, run back downstairs and
back to the session, hopefully the coffee
didn’t run out by then.

Ok, back to the session. Things are run-
ning smooth and the guys are having
fun. Fun? Not on my watch. So | grab a
controller and fire up the RDC and send
it out as an extra to drive the crews
crazy. Oh wait, you can't do that. The
computer has to see the movement or
else like the replacement boxcar, it will
affect ALL future operation schedules.

So, back up stairs, fire up the computer
if you were foolish enough to shut it
down wait OK, Oh the heck with it, you
don’t run the RDC. Besides you're run-
ning out of coffee.

Now | could go on, but the computer,
because of capabilities is great for
PRINTING the waybills, great for
PRINTING the car cards, (have you
ever seen my handwriting)? But for the
actual operation? No thanks, | like to
have fun, instantaneous fun and all that
work is not fun. ®
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SUPPORTING
HoBBY SHOPS

THE BIG LITTLE RAILROAD SHOP
63 WEST MAIN STREET
SoMERVILLE, NJ 08876
PHoNE: 908-685-8892
E-MAIL: BLRRS@CRISP.NET
WWW.BIGLITTLE .COM
11AM - 7PM
11AM - 5PM

F&M HoBBIES

DENBROOK SHOPPING VILLAGE
3118 RT1. 10 WEST

DenviLLE, NJ 07834
PHoNE: 973-361-0042

JACKSON HOBBY SHOP

2275 W. CounTy LINE RD.

BENNETTS MiLLS PLAZA

JacksoN NJ 08527

PHoNE: 732-364-3334

WWW.JACKSONHOBBY .COM

Tues, WED, THURS 10AM - 6PM
10AM - 8PM

THE MODEL RAILROAD SHOP

290 VAIL AVE.

Piscataway, NJ 08854

PHONE: 732-968-5696
WWW.THEMODELRAILROADSHOP .COM

THE JACKSON HOBBY SHOP Sup-
PORTS THE NMRA BY PROVIDING A
10% DISCOUNT ON TRAINS AND
TRAIN SUPPLIES WHEN YOU SHOW
YOUR NMRA cARD. THE REMAIN-
ING HOBBY SHOPS SUPPORT THE
GARDEN STATE DIVISION BY PRO-
VIDING DOOR PRIZES FOR OUR
MEETINGS.

Winter 2008

“Golden Spike” continued from page 12

area of my layout was the first to receive bal-
last and scenery, so this was the focal area
for the Golden Spike. | did have some
scratchbuilt structures to choose from, but
my Walther's roundhouse (weathered,
detailed, interior lighting), my Walther's
Coaling Tower (painted/weathered); an IHC
sanding facility to which | had added a wood
sand bin, would all have qualified. | also
included an overhead crane (Campbell Kit)
and some small scratchbuilt structures as
part of the five required (Figure 3).

This picture shows a small scratchbuilt brick
structure, the Campbell Traveling Crane, the
side of my roundhouse, and some simple
scenery to hold it all together.

Engineering (Civil & Electrical):

There are really three sub-categories to the
Engineering requirement.

First, you must show three types of track-
age, all properly installed and ballasted - all
can be commercial trackage. By 'types of
trackage', the NMRA suggests turnouts,
crossings, grade elevations, etc. To make
things even easier, there is no requirement
that you display three different types of
trackage. Three turnouts would meet the
requirement. In my case, | had many
turnouts (since | was using my yard area for
the Golden Spike). | also had a double
crossover near the entrance to the yard, and
the track leading up to the coal dump for the
coaling tower was a 'grade change'.

Second, you must have your track wired so
that two trains can be operated simultane-
ously. You could do this with DCC, or with
block control in DC. You can also do it a
simply as having a passing siding where you
can 'park’ one train while operating a second
train - then park that one and run the first
again. | met this requirement by having two
blocks and two cabs. | also had sidings
where | could park a train and cut the power.

Finally, you have to provide one additional
electrical feature such as powered turnouts,
signaling, lighted buildings, etc. This can be
as simple as adding some lights in your
buildings. Again, because | used my yard
area, | had powered turnouts as well as

some dwarf signals and lights in some build-
ings.

The Visit:

Once | thought | had met all the require-
ments for the Golden Spike Award, | wrote
up a simple description of the rolling stock,
the structures, and the engineering features
that | thought met the requirements, and
included some photos showing them as
well. Then | contacted Norman Frowley to
set up a time for Norman and his team to
visit my layout to evaluate it for the Golden
Spike. Norman serves as the Chairman of
the Achievement Program for our Garden
State Division. Norman also encouraged
me think about any other aspects of the lay-
out that | might want his team to evaluate.

Because | had completed about forty (40)
square feet of scenery in the yard area, |
also completed the paperwork for the
Master Builder: Scenery Award and decided
to have the team evaluate some of my struc-
tures as well.

The Sunday in early December 2007 that
we had chosen for the visit dawned with an
accumulating snow falling. That didn't stop
Norman and his team (Tom Wortmann and
Tom Casey) from heading 'up north' to West
Milford. The team spent over four hours in
the basement by the layout! (Okay, there
was a coffee break and a lunch break, but
these guys were 'on task' for a considerable
amount of time.) In the end, | had earned
my Golden Spike Award - my original goal. |
also qualified for the Master Builder -
Scenery Certificate and four of my struc-
tures earned Merit Awards. Wow, what a
day!

| really had fun preparing my rolling stock
and my layout for the Golden Spike evalua-
tion. It gave me the motivation | needed to
head downstairs and work in a focused way.
If you have a layout, or a module with track,
| encourage you to consider the Golden
Spike Award as well.  Who knows, you
might already qualify for that and more!
More information about the Golden Spike
Award can be found on the NMRA website
at this address:
www.nmra.org/achievement/gold.html . ®
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\ Chuck Diljak
L% 31 Kuiken Court
Wayne, NJ 07470

The date in the corner of the mailing label shows
when your subscription ends = 1/09

All subscriptions run from January to January

THE TIMETABLE

Friday-Sunday, 3/28-3/30/08, Railroad Prototype Modelers
Valley Forge, Desmond Great Valley Hotel & Conference
Center, One Liberty Boulevard, Malvern, PA. Forty prototype
clinics, vendor rooms, display room for attendee’s models,
and Sunday layout tours. For more information: www.phillyn-
mra.org/rpmmeet.html

Friday-Sunday, 3/28-30/08, 4/4-6/08, 4/11-13/08, The New
York Society of Model Engineers Spring Exhibition, 341
Hoboken Rd, Carlstadt, NJ. Friday evenings 7-10PM,
Saturday and Sunday afternoons 1-6PM. Adults $5, children
$1, children under age 5 Free. For more information:
www.modelengineers.org/

Saturday, 4/12/08, Model Railroad Spring Meet, Sunrise Trail
Division, St. David's Lutheran Church, 20 Clark Blvd.,
Massapequa Park, NY. 10:00AM to 4:00PM. $2.00 for
NMRA/STD Members. Others $3.00. For more information:
www.sunrisetraildiv.com/

Saturday-Sunday, 4/12-13/08, Great Scale Model Train Show,
Maryland State Fairgrounds, 2200 York Rd, Timonium, MD.
Saturday, 9AM-4PM, Sunday 10AM-4PM. General admission
$7, children under 12 Free, family $14. For more information:
www.gsmts.com

Sunday, 5/4/08, NMRA Garden State Division Spring Meet,

The Model Railroad Club, 295 Jefferson Avenue, Union, NJ. 12
Noon. For directions: www.tmrci.com/

Saturday-Sunday, 6/28-29/08, Great Scale Model Train Show,
Maryland State Fairgrounds, 2200 York Rd, Timonium, MD.
Saturday, 9AM-4PM, Sunday 10AM-4PM. General admission
$7, children under 12 Free, family $14. For more information:
www.gsmts.com

Sunday-Saturday, 07/13-19/08, NMRA National Convention:
Anaheim Special, Anaheim Convention Center, 800 West
Katella Avenue, Anaheim, CA. For more information:
www.nmra.org/2008

Sunday, 8/24/08, NMRA Garden State Division Summer BBQ,
Garden State Model Railway Club, 575 High Mountain Road
North Haledon, NJ. 12 Noon. For directions: www.gsmrrclub.org

Thursday-Sunday, 09/11-14/08, NER Regional Convention:
Empire Junction, Holiday Inn, 441 Electronics Parkway,
Liverpool, NY. For more information: www.empirejunction.org

Saturday, 10/25/08, NMRA Garden State Division Fall Meet,
in conjunction with the The New York Society of Model
Engineers Fall Exhibition, 341 Hoboken Rd, Carlstadt, NJ. 10
AM. For more information: http://modelengineers.org/

Thursday-Saturday, 11/13-15/08, Craftsman Structure Show
2008. For more information: www.css08.com

TO HAVE A SHOW OR MEET LISTED, PLEASE E-MAIL THE INFORMATION TO GSDWHISTLEPOST @YAHOO.COM




